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Macs and email: Tips and Tricks v.1

Microsoft Exchange is the server based email package used by the Bow School District to
handle internal and global email and scheduling. The server portion of the program
resides in the Domain BowNET and physically resides in the Media Management Office
at Bow High School. All incoming and outgoing e-mail for BowNET users resides on
that server until accessed by a client.

OSX clients for Exchange can be any of the following:

Apple’s Solution: Mail, Address Book, and iCal: This solution is fast, stable and offers
some advantages over Microsoft’s solution.  Unfortunately, you will not have easy access
to any “contacts” you previously input with Outlook and you cannot currently participate
in group scheduling.

Microsoft’s Solution: Entourage: This solution is slow and occasionally unstable but
you’ll have easy access to any contacts you previously entered in Outlook and you can
participate in group scheduling.

Outlook Web Access: (multi-platform) If you have access to the Internet and any
"frames-capable" browser (i.e. Netscape 3.0 and higher, Internet Explorer 3.0 and higher)
you can access your Outlook mailbox via the World Wide Web. One of the advantages to
this method is that there is no need to setup software on the computer you're using.
Important! While the HTML client will supports 90% of the other client’s capabilities, it
doesn't support all of the capabilities we see in the other Exchange clients.

Recommendations?
Unless you currently use the calendar feature of Exchange to schedule meetings with
other Bow staff, you will most likely be happier with Apple’s solution. Group Scheduling
for iCal is on its way.
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Mail:

Profiles:
Before you can use Mail, you must setup a profile to send/receive
your email. This is done by running Mail, selecting “preferences”
from the “Mail” menu and switching to the “accounts” tab.

Press the “add
account” button and
enter the following
information:

Account Type =
IMAP

Description could be
anything, but we’ll
use “BowNET.org”

Email Address
should be your email
address.

Full Name should be
your full name.

Incoming Mail
Server should be
“mail.bownet.org”

User Name and
password are your
user name and
password.

Where it say’s “Outgoing Mail Server”, you need to enter “mail.bownet.org”, but also
press the “Options” button to set it up to use “Password” authentication, and re-enter your
user name and password.

Close the “preferences” window by pressing okay and any email you have on our
Exchange server should soon appear.
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Sending Email
To send email, click on the "Compose" icon. Destinations for your
email should be indicated in the "To:" and "Cc:" fields. Email sent to
BowNET users should be addressed to their username i.e. "Joe
Blow". Simply click in the “To” or “CC” field and start typing a
name. All possible addresses from your Address Book should soon be listed.
Example: Typing in “BMS” would list “BMS Assembly Committee, BMS CORE, BMS
Crisis Committee, etc…” (If you are not seeing BowNET addresses in your Address
Book, you
probably
need to run
AddressX to
populate your
address book
(see below)).

Email sent to
users outside
of BowNET
should be
addressed
using their Internet address i.e. jblow@aol.com. If addressing email to multiple recipients
within a field, you should separate the names via coma "," i.e. "Joe Blow, Nancy Blow".

It is proper "Netiquette" to include a subject in the "subject" field. Filling
out the "body" of the email is very similar to word-processing in Word.
When finished creating, you can spell check by selecting it from the
"Tools" menu. You send the email by clicking on the "Send" icon.

Attachments:
You may also opt to use Mail to send files (Word Documents, Excel
Spreadsheets, etc.) to email recipients.  To do this, compose and address
your letter as usual, but then click on the "Attach" icon in the toolbar.
You'll get your standard file requester, which you’ll use to find the
desired file/files. Upon pressing the "Okay" button, you should see your
attached file represented in the body of your letter as an icon. You could also elect to
send an “opened” file by going to the application’s “file” menu and selecting “Mail
Recipient” from the “Send To” sub-menu. (not available in all applications).
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Receiving Email:
Email you receive can be read by selecting the header and reading it in the preview pane,
or by double clicking on the icon, which represents the message. A "read" message can
be deleted, stored, replied to, "reply to all"ed (reply sent to all receivers of the originating
email), or forwarded. Received mail can be sorted by “From”, “Subject”, “Date
Received” etc… simply by clicking on the appropriate
header.

Junk Mail:
In these days of SPAM saturation, one of the benefits of using the Mail
program, is its excellent “Junk Mail” filter. By default, when you start
using Mail, the “Junk Mail” feature is in training mode. The headers of
messages it thinks are junk, are display in a red font, while “good” email is
black. You can click on any message Mail should have labeled as Junk, and press the
“Junk” icon in the toolbar. If Mail identifies a piece of mail as junk, which is really
“good” mail, simply click on the message and you’ll have the option of click the “Not
Junk” icon.

After a few days of training, you’ll find that Mail does a pretty good job of differentiating
between which mail is “good” and “junk”. You can then tell Mail what to do with the
Junk mail.

Go to preferences in the “Mail” menu and switch to the “Rule” tab. By
default Mail is setup to look at “all” messages, find those from people “not
in [your] address book”, and classified as “junk” and mark the messages
text in “red”. You could change the action to something like “Delete
Message”, etc..
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Out of Office:

Mail doesn’t have an “Out-of-Office” tool like Outlook, but you can set up a rule to do
the same thing. Go to “Rules” (described above) and create a new rule called “Out of the
Office”, set your conditions to “any Message” and your action to “Reply to Message” and
enter your reply by pressing the “Reply Message Text” button.

 Turn the rule “on” when “out of the office” and “off” when “in the office”.
Important: for a rule to be applied, a computer has to be running and processing your
email.

Can’t read my email, the text is too small!

Mail also has some neat features for the visually challenged. For individual pieces of
email that you find too small to read, you can go “Font” in the
“Format” menu and select “Bigger” or “Smaller”.  To set all of
you email to display with a larger font, select “Preferences”
from the “Mail” menu and goto “Fonts and Colors”. Set your
message font to a larger size.
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Signatures:

It is sometimes desired to have a short message or signature
automatically added to each message you send. To add a signature,
select “Preferences” from the “Mail” menu and switch to the
“Signatures” tab. Press the “Add Signature” button, supply an
appropriate description and type in your signature. Press “OK” to save the signature and
then select the desired signature from the “Select Signature” drop menu.

iCal:
In addition to it’s email abilities, Apple’s solution also functions as a Personal
Information Manager (PIM). As a PIM, it includes a Calendar (iCAl), and a Contact
Manager (Address Book).

When in iCal, you can switch between,
Day, Week, and Month views by clicking
on the appropriate tool.

To add a new appointment, double-click on the day you wish the event to occur on or
select “new event” from the “File” menu.  In the resulting window, you can enter the
“Subject” of your meeting, the “Start” and “End”
times of your meeting, and which calendar this
meeting is for (iCal allows you to track multiple
calendars , i.e. personal, work, etc..).

Moving along the toolbar, from left to right you can:
• access the “alarm” tab where you can tell

iCal to email you, display a message, or play
a sound to remind you of your event.

• access the “recurrence” tab where you can
tell iCal to repeat this meeting daily, weekly,
monthly, or yearly

• access the “invite” tab where you can invite
others to attend the event with you.
Important: this currently works only with
iCal to iCal users. A software release is
forthcoming which will allow you to make
appointments with Outlook and Entourage
users.

• access the “notes” tab, where you can keep
notes on the event itself.
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Address Book:
While in “Address Book”, you can add a new person, by clicking on the “Add Person”

tool or by selecting “New Card” from the file menu. Enter the appropriate
information into the
appropriate box and
you’ve created your
contact. Since this

information is all stored as a database,
all of the contact information is
searchable.

To add a group (distribution list), click
on the “Add New Group” tool or select
“New Group” from the “File” menu.
Name the group, and find the
appropriate members from your other
groups to add to the new group.
Members of a group can include users
and lists from either the global list or your own Contacts. To send email to this list in the
future, you'd simply type in the name of the group.

Important: If you previously used Outlook as your email client, you may notice that
your contacts are not visible. Unfortunately, Apple’s “Address Book” and Microsoft’s
“Contacts” are not directly compatible. To view your Microsoft “Contacts’, you will need
to first open them in Outlook, then export them as vCards, then import them back into
Address Book.

Address X:
If you don’t see the
members of the global
address book in
Apple’s Address
Book, you’ll need to
use Address X to copy
them over as follows:

1) Select
“Applications”
from the “Go”
menu and run
Address X

2) User Account = bownet\username, Password = your password, and “Exchange
Server” = mail.bownet.org

3) Once that information is in, AddressX automatically switches to the Update tag,
where you can import the contacts by pressing “Update Now”. You should also set it
to “Automatically Update” weekly.
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Entourage Client:

Profiles:
Before you can use Entourage, you must setup a profile to
send/receive your email. This is done by running Entourage, and
selecting  “Accounts” from the “Tools” menu. Select “Exchange”
from the “New” tool. Account ID = username, password =
password, and Domain=bownet.org. Press the right arrow to
continue.

If all goes well, Entourage will automatically take care of all of the other settings for you.
If things don’t go well, call your building Tech Assistant. Press “finish” to “finish”. Close
the “Accounts” window.

Within a few minutes, Entourage should be synchronized with our Exchange server and
ready to use.
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Sending Email

To send email, click on the "New Message" icon. Destinations for your
email should be indicated in the "To:" and "Cc:" fields. Email sent to
BowNET users should be addressed to their username i.e. "Joe Blow".

Simply click in the “To” or “CC” field and start typing a name. All possible addresses
from your Address Book should soon be listed.
Example: Typing in “BMS” would list “BMS Assembly Committee, BMS CORE, BMS
Crisis Committee, etc…” If you are not seeing BowNET addresses in your Address
Book, press the “Check Names” button. If you still don’t see the addresses, you probably
need to run AddressX to populate your address book (see above).

Email sent to users outside of BowNET should be addressed using their Internet address
i.e. jblow@aol.com. If addressing email to multiple recipients within a field, you should
separate the names via coma "," i.e. "Joe Blow, Nancy Blow".

It is proper "Netiquette" to include a subject in the "subject" field. Filling out the "body"
of the email is very similar to word-processing in Word and
shares many of the same tools. When finished creating, you can
spell check by selecting it from the "Tools" menu. You send the
email by clicking on the "Send Now" icon.

Attachments:
You may also opt to use Entourage to send files (Word Documents, Excel Spreadsheets,

etc.) to email recipients.  To do this, compose and address your letter as usual,
but then select "Add Attachment" from the "Message" menu or press the
“Attachment button. You'll get your standard file requester, which you’ll use to
find the desired file/files. Upon pressing the "Okay" button, you should see

your attached file represented in the body of your letter as an icon. Press "Send Now" to
send. You could also elect to send an “opened” file by going to the application’s “file”
menu and selecting “Mail Recipient” from the “Send To” sub-menu. (not available in all
applications).
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Receiving Email:
Email you receive can be read by selecting the header and reading it in the preview pane,
or by double clicking on the icon, which represents the message. A "read" message can
be deleted, stored, replied to, "reply to all"ed (reply sent to all receivers of the originating
email), or forwarded. Received mail can be sorted by “From”, “Subject”, “Date
Received” etc… simply by clicking on the appropriate header.

If storing and sorting email, you may wish to utilize "sub folders" in Entourage. First of
all, make sure that you can see folders by going to the "View" menus and verifying that
"Folders" is selected.  Folders can be added by selecting "New Folder" from the "File"
menu. Drag items from your "Inbox" to the folder or sub-folder of your choosing.

Calendar:
In addition to it’s email abilities, Entourage also functions as a Personal
Information Manager (PIM). As a PIM, it includes a Calendar, a
Contact Manager, a Task Scheduler, and more. To switch into Calendar
mode, press the Calendar button on the vertical toolbar.

When in the calendar, you can switch between, Day, Work Week, Week, and Month
views by clicking on the appropriate tool.

To add a new appointment, click on the “New Calendar Event” tool or press the “new”
hotkey (anyone remember that from previous lessons?).  In the resulting window, you can
enter the “Subject” of your meeting, the “Location” of your meeting, the “Start” and
“End” times of your meeting, “Notes” for the meeting, and set a “Reminder” for the
meeting.  Select options from the “Occurs” drop menu to setup a reoccurring meeting
(i.e. the first Tuesday of every month, every Wednesday and Friday, etc…).
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You can also invite other BowNet users with email accounts to attend your meeting. If
you chose to do this, each “invitee” will receive an email, which contains the details of
the meeting (as your entered in your appointment) and give them a chance to either
accept the meeting or decline it. Should they accept, the details of the meeting will be
automatically entered into their calendar and you’ll be notified of their acceptance.
Should they decline, you’ll be notified of their absence.
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Contacts:
To switch to contacts, click the “Address Book” tool on the vertical toolbar (not to be

confused with Apple’s “Address Book”). While in “Address Book” view,
you can add a new contact, by clicking on the “New” tool or press the
“new” hotkey.
Enter the
appropriate
information into
the appropriate

box and you’ve created your
contact. Since this information
is all stored as a database, all
of the contact information is
searchable (as is any of the
information in Outlook).

To add a group (distribution
list), switch to “Address Book”
and from the “File” menu
select, “\new\group”. Name the
group, and press the “select
members” button to add
addresses to your list.
Members of a "distribution
list" can include users and lists
from either the global list or
your own Contacts. Press
"okay" when finished. To send
email to this list in the future,
you'd simply press “To” and
switch to “Contacts” instead of
the default “Global” list.

Important! Due to a bug in
Entourage, you may have
difficulties adding members to
a “group” unless you’ve
already sent them email using
Entourage.
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HTML Client:

If you have access to the Internet and any frames capable browser (i.e. Netscape 3.0 and
higher, Internet Explorer 3.0 and higher) you can access your Outlook mailbox via the
World Wide Web. One of the advantages to this method is that there is no need to setup
software on the computer you're using. To do so, start your browser and go to
http://mail.bownet.org/exchange

1) username=jblow
2) password=?
3) domain=bownet
4) Hit Okay and read email

If your browser only provides a 2 line authenticator, username=bownet\jblow (please
note the "\" is not a "/" which won't work)
The Outlook Server will then generate a web page, which looks and acts like your Inbox.

Important! When finished accessing Outlook via the World Wide Web, you should click
on the "Log Off" link and then exit the browser.


